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: GETTING STARTED USING
8-BIT MCUs IN THE MPLAB®
MICROCHIP Xpress ECOSYSTEM

Chapter 1. Overview of the MPLAB® Xpress Ecosystem

1.1 INTRODUCTION

MPLAB® Xpress is an ecosystems is comprised of:

« MPLAB Xpress IDE

* MPLAB Code Configurator

« MPLAB Xpress Evaluation Boards
e Other Compatible Hardware

1.2 MPLAB XPRESS IDE

MPLAB Xpress cloud-based IDE is an online development environment that contains
the most popular features of our award-winning MPLAB X IDE. This simplified and dis-
tilled application is a faithful reproduction of our desktop-based program, which allows
users to easily transition between the two environments.

MPLAB Xpress is a perfect starting point for new users of PIC® microcontrollers
(MCUs) — no downloads, no machine configuration, and no waiting to get started on
your system development.

MPLAB Xpress incorporates the latest version of MPLAB Code Configurator, which
enables users to automatically generate initialization and application C code for 8-bit
and 16-bit PIC MCUs and dsPIC® DSCs using a graphical interface and pin map.

With massive amounts of storage available to users, you can store your current proj-
ects in the cloud. The Community feature allows you to share your ideas with others,
or gain inspiration from the shared code repository.

Best of all, MPLAB Xpress IDE is free, and can be accessed from any Internet-con-
nected PC or Mac, anywhere in the world.

1.3 MPLAB CODE CONFIGURATOR

MPLAB Code Configurator (MCC) is a free, graphical programming environment that
generates seamless, easy-to-understand C code to be inserted into your project. Using
an intuitive interface, it enables and configures a rich set of peripherals and functions
specific to your application.

MPLAB Code Configurator supports 8-bit, 16-bit and 32-bit PIC microcontrollers. MCC
is incorporated into both the downloadable MPLAB X IDE, and the cloud based MPLAB
Xpress IDE.

1.4 MPLAB XPRESS EVALUATION BOARDS

MPLAB Xpress evaluation boards are the easiest way to get started. They feature an
easy-to-use USB programmer, and offer full access to the features of the target MCU.

© 2018 Microchip Technology Inc. DS50002710A-page 5



Using 8-bit MCUs with MPLAB® Xpress

1.5 OTHER COMPATIBLE HARDWARE

Additional hardware that may be used with MPLAB Xpress IDE are listed below.
Curiosity Development Boards

Curiosity Development Boards are cost-effective, fully integrated MCU development
platforms targeted at first-time users, makers, and those seeking a feature-rich rapid
prototyping board. The family offers a full on-board programmer/debugger, and several
add-on board options.

Explorer 16/32 Development Board

The Explorer 16/32 Development Kit is a flexible, convenient and ready to start devel-
opment, demonstration and testing platform for 16-bit PIC24 MCUs, dsPIC DSCs and
32-bit PIC32 MCUs. It features all the necessary hardware to begin developing and
debugging a complete embedded application.

PICKit™ 3 Programmer/Debugger

PICkit 3 is a standalone programmer/debugger for use with any PIC MCU or dsPIC
DSC DSC. PICKit 3 is the perfect option for those with their own custom prototype hard-
ware.

DS50002710A-page 6
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Chapter 2. Equipment Used

2.1

2.2

2.3

2.4

INTRODUCTION
This content of this document was developed using the tools listed in the following
sections:
* Hardware
« Software
« Additional Resources

HARDWARE

* MPLAB Xpress Evaluation Boards: http://www.microchip.com/xpress
« USB cable type A to type micro-B

SOFTWARE

* MPLAB Xpress IDE: http://www.microchip.com/xpress
* Free Terminal Emulation Software:
- Tera Term (Windows only): http://www.teraterm.org
- CoolTerm (Windows, Linux, MAC OS): http://freeware.the-meiers.org/

ADDITIONAL RESOURCES

* MPLAB XC8 C Compiler Homepage: http://www.microchip.com/xc8
* MPLAB Code Configurator Homepage: http://www.microchip.com/mcc
« MPLAB Xpress Wiki Homepage: http://microchip.wikidot.com/xpress:start

© 2018 Microchip Technology Inc. DS50002710A-page 7
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NOTES:
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Chapter 3. Programming the Evaluation Board

3.1 INTRODUCTION
The purpose of this lab is to introduce basic concepts of the MPLAB Xpress IDE with
one of the available example projects.
¢ Opening an Example Project in MPLAB Xpress IDE
» Download an Example Project to the Evaluation Board
« Setup Serial Communication with the Evaluation Board
e Programming Result

3.2 OPENING AN EXAMPLE PROJECT IN MPLAB XPRESS IDE

1. Navigate to the MPLAB Xpress IDE homepage and click on the Examples link at
the bottom of the page under the “Community” heading:
https://www.microchip.com/xpress

Community

e

OR

You can navigate directly to the examples page via:
https://www.microchip.com/xpress/examples

OR

Navigate to the examples page from within the MPLAB Xpress IDE by clicking
on the Examples link at the top of the IDE window.

oW INTROQUCTION | EXAMPLES TFORUM 8| WD of DESIGM
5 P & - &b ||rcom FT"
- '!, J

4 (Bl Using_MPLAB_Xpress_Bxamples 1=§
) Heacer Fies
B sowrce Files

-------
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Using 8-bit MCUs with MPLAB® Xpress

2. Onthe MPLAB Xpress Examples homepage, filter through the examples as fol-
lows:
a) Author: Microchip Technology
b) Tags: #GettingStarted
¢) Board: Xpress Board
d) Device: <the device you are using>
In this example the PIC16F18877 is used.

The name of the device populating a given MPLAB Xpress Evaluation Board
can be found next to the board's USB connector.

Scroll through the available examples and locate “Using MPLAB Xpress Exam-
ples”. A description of the example, along with any additional resources which
could include videos links to step-by-step tutorials and more, can be accessed
by clicking on the title of the example.

Open the example inside the online MPLAB Xpress IDE by clicking on the [Ji=)
button in the Open column.

MPLAB Xpress Code Examples

Title Author  Like  Watch  Impor Tags Board Davice Updated Open Y

a0
T
e o o |
o 0 0 i 0 |
e [ O |
e o 0 =

| s /
£ T

“reata { X ﬁ\ o r ﬂ

@ o T
T 0 #Gatting Started Xpress Board wowzory A
< 55 Board N 0 |
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Programming the Evaluation Board

S\ IDE - MPLAB Xpress x

&« C | @ Secure | https://mplabxpress.micrachip.com/mplabcloud/ide

File Edit View MNavigate Source Run Debug Tools Window

e ag~ @
Project
o (5] Using_MPLAS_Xpress_Examples

(65 Header Files

(65 Source Files

LI mane

Dashboard

2 | %8 Using_MPLAS Xpress_Examples
/| G Device

5 G PIC16F13877

el ®

b 8 Checksum: Blank, no code loads
§' Compiler Toolchain
Lf_u' XC8 (142)
(& Memory
% Debug Tool

‘- @) simulator / Xpress Board

- §F Debug Resources

BB DR
4

void main{void)

SYSTEM_Initialize({);

| OV L1 LW W

@ o
(SRR R R A )

63
G4
65
66
&7
68
69
e

Output x

All source code is available along with information related to the development
tools and device that the project was configured to use.

© 2018 Microchip Technology Inc.
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Using 8-bit MCUs with MPLAB® Xpress

3.3 DOWNLOAD AN EXAMPLE PROJECT TO THE EVALUATION BOARD

1. Connect the MPLAB Xpress Evaluation board to an available USB Port on the
computer.

2. Once connected and the device drivers have completed installation, the MPLAB
Xpress Board should be recognized as a Mass Storage Device on the Host Com-
puter and listed as an available drive (Windows® Explorer shown here).

=™ Computer
m &L, 0sDisk (C:)
[# @ My Passport (E:)
 (Q CD Drive (F:) WD SmartWare

@ S OLD PRICTS (G:)

» &) umw XPRESS (I:)

@ [ REACHt Drive

3. Click on the Make and Program Device & button at the top of the MPLAB
Xpress IDE to generate and download a . hex file that will be used to program

the PIC16F18877 microcontroller populating this particular MPLAB Xpress Eval-
uation Board.

In some browsers the generated . hex file may be available within the browser
window or may need to be accessed from a “Downloads” folder associated with
the browser. Navigate to the downloaded . hex file and drag it into the XPRESS
directory shown in Step 2.

1M Computer
&L osoisk (C3)
a badwp drive (E:)
2 CD Drive (F:) WD SmartiWare

Drag and Drop

Once the Usi ng_MPLAB_Xpr ess_Exanpl es. hex file has been dragged and
dropped into the XPRESS directory, the LED on the MPLAB Xpress Board will
briefly flash red indicating that the PIC16F18877 is programmed.

DS50002710A-page 12 © 2018 Microchip Technology Inc.



Programming the Evaluation Board

3.4 SETUP SERIAL COMMUNICATION WITH THE EVALUATION BOARD
1. Open aterminal emulator program on the host computer and select the COM
port associated with the MPLAB Xpress board.

In this example a free program called CoolTerm is used. If using CoolTerm, open
the Connection>0Options dialog and configure the serial port at the 9600 baud

rate.

Note: The COM port number will vary from that shown below.

Click OK to continue.

Connection Options (CoolTerm_0)

Serial Port
Terminal
Receive
Transmit
Miscellaneous

Port:
Baudrate:
Data Bits:
Parity:
Step Bits:

Flow Control:

# DTR On
 RTSOn

~Serial Port Options

Initial Line States when Port opens:

IS -
IHDHE i
Il -
- cTs
[~ DTR
[~ XON

" DTR Off
" RTS Off

Re-5can Serial Ports I

Cancel I OK I

2. Inside the terminal window, click on the Cemmect button to establish connection
with the MPLAB Xpress board.

© 2018 Microchip Technology Inc.
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Using 8-bit MCUs with MPLAB® Xpress

3.5 PROGRAMMING RESULT

Once communication is established, the terminal window should display the message

“Hello from your Xpress board!”

File Edit Connection View Window Help

=1oix|

&8 B #

MNew Open Save | Connect Disconnect

&

Clear Data

Options

HEx

Wiew Hex

Help

ol

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Epress board!

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Epress board!

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Epress board!

Hello from your Xpress board!

Hello from your Xpress board!

Hello from your Xpres|

4

COM7 /9600 8-N-1
Connected 00:01:22

(J RTS (J DTR @ DCD
@CTs @DR @R

DS50002710A-page 14
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0 GETTING STARTED USING

Chapter 4. Launching M PLAB® XpressMCC Plugin

4.1 INTRODUCTION

This chapter demonstrates how to launch the MPLAB Code Configurator (MCC) plugin
from within MPLAB Xpress IDE. MCC is a free graphical programming environment
that generates seamless, easy-to-understand C code that is inserted into your project.
Using an intuitive interface, MCC enables and configures a rich set of peripherals and
functions.

The example project from the previous chapter will be used.

* Opening the MCC Plugin for the First Time

* MCC in MPLAB Xpress

4.2 OPENING THE MCC PLUGIN FOR THE FIRST TIME
1. Launch the Manage MPLAB Xpress Code Configurator dialog by clicking on

the @ button at the top of the IDE or
through Tools>Embedded>MPLAB Xpress Code Configurator.

© 2018 Microchip Technology Inc. DS50002710A-page 15



Using 8-bit MCUs with MPLAB® Xpress

The Manage MPLAB Xpress Code Configurator dialog should now be open.

Manage MPLAB Xpress Code Configurator -

This application requires Java 8 to be installed. Please follow these steps to install and run MPLAB

Xpress Code Configurator.

(( STEP 1 _ ]

c._-) L
S x =
oo s
Which version do | have installed? Meore Information

STEP 3

Enter or paste

adaf6346-95a2-4f2c-be70-68a0604ebieb ﬁ ﬁ

Ok

2. STEP 1 ensures that the latest Java Runtime Environment (JRE) is installed on
your computer. If unsure of the current version of the JRE on your computer, click
on the 'Which version do | have installed?’ link and follow the steps.

How To Find Java Version “

You can use the following link to determine which version of Java you have installed on your PC
hitps /iwww java com/en/downloadiinstalled jsp

If your browser does not support the Java Plugin, you can find more information here:
hitps:/iwww java.com/en/download/help/version_manual xml

If you still need help, please do not hesitate to contact us, using the Feedback button at the top of the IDE.

Ok

DS50002710A-page 16 © 2018 Microchip Technology Inc.



Launching MPLAB® Xpress MCC Plugin

Clicking on the green Download & Install JRE button will redirect you to the
Java Runtime Environment homepage. To install JRE, simply follow the instruc-
tions.

A\ IDE - MPLAB Xpress

[« B W () Oracle Corporation [US] | https://java.com

Dowrload ~ Help

AllJeva Downidats Free Java Download

Ifyou want to download

Java for another computer Download Java for your deskiop computer now!
or Operating System, click Version 8 Update 73

the link below Release Date February 5, 2016
All Java Downloads

Report an issue 2 Free Java Download

Why am | always rediractad
10 this page when visiting a
page with a Java app?

» Leamn more

» Report an issue

» Whatis Java? » Dolhave Java? » Need Heln?

Why download Java?

Java technology allows you to work and play in a secure computing environment Upgrading to the latest
Java version improves the security of your system, as older versions do not include the latest security
updates

3. STEP 2is used to download the necessary . j nl p file to launch MCC.

MCC is a Java application that runs directly from the internet using a web
browser (Chrome is used here). This requires the use of the Java Web Start
application software which follows the Java Network Launching Protocol (JNLP)
to download and launch the application.

a) Clickthe green Download MCC button to download the JNLP file. Then click
on the MCC_Xpr ess. j nl p file to launch the Code Configurator.

Today

MCC_Xpress -!] jnlp

b) Click Run when prompted to run the application.

Do you want to run this application?

Name: com.microchip.mcc.standalone.Standalone
«
=7 Publisher: Transim Technology Corp.
e
Location: https://mplabxpress.microchip.com
This application will run with unrestricted access which may put your computer and

personal information at risk. Run this application only if you trust the location and
publisher above.

Do not show this again for apps from the publisher and location above

E More Information Run Cancel

© 2018 Microchip Technology Inc. DS50002710A-page 17



Using 8-bit MCUs with MPLAB® Xpress

c) The Enter Token from MPLAB Xpress window will now open.

[N Enter Token from MPLAB Xpress x|

or select Cancel to dose this application.

The Token you have entered is not valid. Please enter your unique Token to connect this toal to your Online IDE Session o
To find your teken from within the IDE, go to the "Toels" menu and then "MPLAB Xpress Code Configurator”

==ty S gV T e Bl 4038328 -4194-4a04-8fed-3c2beB47h522)] l

[0, Cancel

4. STEP 3 provides a unique token value that will be used in the Enter Token from
MPLAB Xpress window. To locate the token, return to the Manage MPLAB
Xpress Code Configurator window. Then click on the Copy button next to the
unique token value.

Manage MPLAB Xpress Code Configurator “

This application requires Java 8 to be installed. Please follow these steps to install and run MPLAB
Xpress Code Configurator

¢ ST

= - ;
Duwnload & Install JRE Downlaad MCC
Which version do | have installed? More Information
' STEP 3

Enter yste this unique token into the

§ C28707d72-c720-4800-ad96-41bd69c 778ba
| f
unique token value Copy token value
Ok

5. Return to the Enter Token from MPLAB Xpress window. Past the copied token
value into the “Please enter your Token” field.

X enter Token from MPLAB Xpress ‘El

or select Cancel to close this application.

The Token you have entered is not valid. Please enter your unique Token to connect this tool to your Online IDE Session o
To find your token from within the IDE, go to the "Tools” menu and then "MPLAB Xpress Code Configurator”

—— Undo =

Cut

Copy

Delete

Salact all

DS50002710A-page 18 © 2018 Microchip Technology Inc.



Launching MPLAB® Xpress MCC Plugin

6. Click OK to initialize the device-specific libraries for the microcontroller selected

and open the MCC.

If the token is not valid, refresh the token value in STEP 3 by clicking on the

Refresh Token Value button n in the Manage MPLAB Xpress Code

Configurator window, recopy the new Unique Token Value, and paste into the
“Please enter you Token” field of the Enter Token from MPLAB Xpress window.

4.3

MCC IN MPLAB XPRESS

The MCC is a graphical programming environment used to configure device features
including oscillator setup, peripheral configuration and assign signals within the micro-
controller to pins on the device package. You are encouraged to take some time and

explore the configurator to see how the MCU was configured to implement the “Using

MPLAB Xpress Examples” example project.

Praject Resources
Py

et Mokl

P e

St Vosle
g —

Device Resources

Al x|

MICROCHIP

PIC16F18877

Versions.

¥ ML Coe Corfgrtir 1082

Rpre—

PatA T

owomom (0|23 ]a|s[6]2|0[a[2]3]a/s[6]7|0ja]2]s[a]s][a]r|[0]a]2

St

nahenE

Pame (17 18[19 203 22| 2| s 9 10 1 [a2 a3 1e 15|50 303 33 e e a0 2 3e 3|2

Partn Y P Gl

bbb EEEEEEEEE
/BB b/s 0 e b e E
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Using 8-bit MCUs with MPLAB® Xpress

Source and header files generated for the original project can be viewed in the Project
pane of the MPLAB Xpress IDE under the Header Files and Source Files folders.

3 IDE - MPLAB Xprass

& > C | & Secure

X

https://mplabxpress.microchip.com/m

File Edit View Navigate Source Run Debug Tools Window

o & & % ™| 5% - 58 . B B, B PC: 00
™ . w | U [=} a2, * B || pc:od
!ro)a *

... [ Using_MPLAB_Xpress_Examples

72 SPIBRGH = @x@8;

7 74}

Lo 9 eusarth

b ) mech uint8_t EUSART Read
¥ pin_manager.h gt {

4 (i3} Source Files

i A [gF) MCC Generated Files

(void)
while(!PIR3bits.RCIF)
{

- evsart.c

o ] mecc

Lo (8 pin_manager.c
b (B mainc

if(1 ==

RCISTAbits.OERR)
{

RC1STAbits SPEN = ;
RC1STAbits.SPEN = 1;

return RCIREG;

d EUSART_Write(uint8_t txData)

while(@ == PIR3bits.TXIF)

TXIREG = txData;
3
}

char getch(void)

return EUSART_ Read();

Output x
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Chapter 5. Usingthe M PLAB® Code Configurator (MCC)

5.1 INTRODUCTION

The MPLAB Code Configurator (MCC) is a Graphical User Interface (GUI) that gives
the developer a high level view of a given microcontroller making it much easier to con-
figure:

« Core device capabilities

* Peripherals and configuration

¢ MCU signal pin assignment

* Related libraries

These features can all be configured through the use of intuitive drop-down menus,

check boxes, and fields. In this way the developer can quickly configure the target
device, minimizing the amount of time spent reviewing registers in a data sheet.

Key MCC tool areas are shown in the screen capture below.

)
Pacier Laav7 Gererate Urda Fado Save Qe
Pro]ﬂl Resources SYSMIII Module 0
T :
Irtmrngt Module =

Fin Madde

o ULLILLOULIUD

Systern Mocke

1Tz =[]
Al | =t Y
2l

MIiCROCHIP =Bl
PIC16F18877

v Fenphesss

Pin Manager

Package
package: | v | < | | mmMoc |17] 1819 203 22 20 | am| @ | 9 10|21 52 13|14 ] 15 30|31 32 |33 38 | 0 a0 |
PortAY | Pot ¥ | PartC¥

Maodule T thom Darection o|11213 :5(.o.1.2.3.‘.s.°.".°.'.z.3.'.5.(’.

— per | | | ] 1] ] § CRCRC TSN HC TN B B RO R T
ot | L L L L L] CRCRC S S NCRC N RO RO N T T T

ot B

vssew T rot IO
I e mmmmm B bbb e e h R
» S5 Bootioader Library BT MR st |

Pin Manager Table

Key tool areas are discussed further in these topics:
» Project Resources

» Device Resources

e Composer Area

e Pin Manager
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5.2 PROJECT RESOURCES
Displays device features currently being used in this project.
5.2.1 System Module

Configure core parameters such as the system clock, configuration bits and other
device-level functions.

Project Resources System Module

v System 5% Easy Setup | =] Registers | /4 Notifications : 0
Interrupt Module 5% Easy Setup | (=] Registers | ¢, Notifications :
Pin Module: ~ INTERNAL OSCILLATOR
Bz Current System clock 1 MHz
- Pariphesals
Oscilotor Select | HFINTOSC (1MH2) =]
(= EUSART [PIC10/ FIC12 [ PIC16 / PIC18 MCUs by Micrachip Technology, Tnc.1[X]

External Clock Select | EC above 8MHz; P

HF Internal Clock | 4_Mrz [ -]

External Clock

~PLL Capable Frequency

1 MHz

okonmr (= [ =]

Lovi-voltage programming Enable

v WWDT

Watchdeg Timer Enable | WDT Disablad, SWDTEN is ignored | - ‘

Clock

Clock Source

Window Open Time

Time-out Period Divide

5.2.2 Interrupt Module

Enable or configure interrupt priority for interrupt sources available in the project.

Project Resources Interrupt Module

v Systsm =
£5% Easy Setup | /8 Notifications : 0

Interrupt Module &

Pin Modue UL

Systen Module 8, Flease remember to enable the Peripheral and Gobal Interrupts i your cade!
 Peripherais

Inke Vet
{4 EUSART [PIC10 / PICL2 / PICL6 { PICIE MCLs by Micrachip Technlogy, Inc] 2l

order | 4p up || 4L Down Preemptive interrupt routine

Order Module Interrupt Enabled
1 |EUSART ™ U
2 EUSART RI ™
3 Fin Module 101 ]

5.2.3 Pin Module

Configuration of individual pins selected from the Pin Manager such as pin direction
(input or output), analog functionality and weak pull-up resistors, if available. In some

instances a custom name can be given for a pin that will be referenced throughout gen-
erated code.

Project Resources

Pin Module
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5.3 DEVICE RESOURCES

This area displays features that are available for use for the selected target device.
Features are added by double clicking on the listing in the Device Resources section.

Device Resources ) =

¥ Documents

PIC16F18877 Product Page
w» Peripherals

L‘.T ADCC

" OCP

®s CLC

©crc

3
3
3
3
b G OWG
¥ -‘é-CIock Reference
» [l Comparator
3 '_.J"DAC
» A Dsm
b [=1EUSART
b [1Hf] Ext_Interrupt
b —FUR
b MSEP
v (5 Memory
B TUL NCO
» UL PAM
b @ smT
b (%) Timer
b E57CD
w Libraries
» & Foundation Sarvices
»  Mikro-E Clicks

5.3.1 Product Page

Links to the selected device's product homepage where the data sheet and other doc-
umentation, such as relevant application notes, can be found.

Device Resources () =

» Documents
PIC16F18877 Product Page

w Peripherals

b Syapcc
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5.3.2

Peripherals

Displays all peripherals that are available on the selected target device. Different
devices will have different peripherals. Peripherals are added to the project by double
clicking on the listing.

w Peripherals
ﬁ-? ADCC
o CCP
®s CLC
O cre

5 oniG

»
»

»

»

»

»

»

b o DAC

b A osm

» [=]ELSART
»

P —FVR

b2 MEEP
b [ Memory
B TULNCO

» I FM
» GsmT

b (%) Timer
»

L 70D

% | Clock Reference

Ll Comparator

74| Ext_Interrupt
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5.3.3 Libraries

Lists available libraries that have been created to simplify certain functionality such as
using serial communication protocols. These libraries are presented to the user as any
other module in the MCC using an easy-to-use graphical interface to configure various
library parameters. Libraries are added to the project by double clicking on the listing.

Device Resources

¢ Documents

p Peripherals

w Libraries

¥ = Foundation Sarvices

% [2CMASTER.
% [2CSIMPLE
% [2CSLAVE
% SPIMASTER
% SPISLAVE
(+) TIMEOUTDRIVER

fg] UART

p  Mikro-E Clicks
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534 MIKRO-E Clicks

MikroElektronika Click Boards are expansion daughter cards featuring various types of
sensors, communication modules and other interface components that can be used
with the target device to quickly add additional functionality to an application. Click
boards are added to the project by double clicking on the listing in the Device
Resources, which adds required peripherals as needed that interface with the selected
module.

Device Resources

¢ Documents
p Peripherals
» Libraries
w Milro-E Clicks
w» Intesface
7 4-20ma R
[ 4-20maT
[7) CAN SPIT
fd ETH
{77 EXPAND
{77 MCP20036
{ Rs232
] R485
[7) USE UART
77 UsBI2C
7] UsBsP
Mixed-Signal
Sensors
Wirgless Connectivity
Human-Machine Interface
Storage
Motor Control
Display
Audio and Vioice
Clack and Timing

Miscellzaneous

v v v ¥ ¥ w¥ w¥ w¥ ¥
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5.4 COMPOSER AREA
Main interface area in which a peripheral, library or driver is configured.

541 Easy Setup Tab

This tab presents the peripheral, library or driver at a high level so that it can be config-
ured using intuitive check boxes, value fields and drop-down selections (EUSART
peripheral Easy Setup shown).

Project Resources EUSART Q
» System 5% Easy Setup | = ister /A Notificati o

Interrupt Mdule <% Easy Setup || F5 Registers | £\ Notificatians :

Pin Module Hardware Settings

System Module

v Mode [ asynchronous | ~ |
« Peripherais

[ EUSART [PIC10 / PIC12 / PIC16 / PIC18 MCUs by Micrachip Tachnalogy, Inc.] [X] Enable EUSART Beud Rate: 600 [ ] emor: 0.160%

-

Dot roommees [s6 [ -]
[[] Auto-Boud Detection  clock Polarity: Non-Tnverted [ -]

[] Enable sddress Detect Enable Continuous Recsive

[[] enable EUSART Interrupts

~ Software Settings

Redirect STDIO to USART
Software Transmit Buffer size | 5 | ~ |

Software Receive Buffer Size | 5 | = |

5.4.2 Registers Tab

Presents the registers associated with device peripherals and features. Registers can
be configured using either drop-down menus or by entering a hexadecimal value next
to the register name representing individual bit settings (EUSART peripheral Registers

shown).
Project Resources EUSART
w System
455 Easy Setup || =] Registers | /8, Notifications : 0
Interrupt Module <57 Eaey Setup | = Registers | &) Notifcations
Pin Module ML
System Module Interupt Enables
w Peripherals I:‘ .
=] EUSART [PIC10 / PIC12 | PIC16 | PIC18 MCUs by Micrachip Technaloay, Inc.]
[

v Register: BAUDICON |

2EDEN | chsabled [ -]
o [z 7]
BRG15 | 18bit_generator -

RaDL | e i
or [ [5]
we [ ]

 Register: RCIREG 19

RCIREG | 0D

v Register: RCISTA | 00

oo [amm [ 7]
oor [ []
SN —

RXSD 0x0
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5.4.3 Notifications Tab

This tab displays important information concerning various modules that have been
configured including warnings, hints and general information (EUSART Notifications
shown where the System Clock was set to a lower frequency that is insufficient to

obtain the desired Baud rate).

Project Resources

v Systam
Interrupt Module
Pin Module:
System Module
v Peripherals
[=) EUSART [PIC10 / PIC12 [ PIC16 f PICI8 MCUs by Micrachip Technology, Inc.]

System Module

Easy Setup | =] Registers | /4 Notifications : 1
C.ategnryl Module Name | Type | Description ‘

& |evsaar [FanT |Boud rete arror excesds 2% |
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5.5 PIN MANAGER

Many signals internal to the device can be routed to a user-selectable variety of pins.
Signals can even be routed to multiple pins at the same time and pins can be shared
by multiple modules. The Pin Manager simplifies this process using Table and Package
views.

55.1 Pin Manager Table View

Lists the pin by package pin number across the top of the table, by Port just below the
pin number and by Module, signal Function and Direction along the left side of the

table.
Package: LO_FN4CI|' | Pin No: 17|1s|19|zn|21|22|29|zs s|9|1n|11|12|13|14|1s 3n|3
PortAY PortB ¥

Module Function Direction |0 | 1|2 |3|4|5|6|7|0|1|2|3|4|5|6|7|0
RX input NGRSk

EUSART ¥
L output GGG IR

asc CLKOUT output i

o Hodda | input GG GGG GG R B R S
GFIO output R - - R R R R B

RESET MCLR input

* Blue colored pins E indicate pins that can be used by a module signal.

« Green colored pins (with a lock) ] indicate that the pins have been allocated to
a module signal.

» Green colored pins (with a chain link) %I indicate that the pins are shared
between multiple modules.

 Yellow/Orange colored pins f- indicate possible alternate pins for an already
allocated pin function.

* The Package drop down menu can be used to change the Package View to any
available package for the target device.
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55.2 Pin Manager Package View

Displays pins on the selected device package. Color codes follow above adding Gray
colored pins indicating that the pin is not usable in the selected configuration. Micro-

controller signals can also by assigned to pins in this view by right clicking on the pin
and selecting the available signal.

ERAREAEEB68EAREA
Fa A TR S [ o e L T N W S
o UL LULLIULIL
40 39 38 37 36 35 34 33 32 31
rRe7[ 1 30[_|rco
rRoa ]2 29[ |ras

RDS[ ]3 28 [ |Ra7
RDG| |4 27 [l vss

w5 MICROCHIP zHvwe

vss|lle 25 |rE2
voo [l PIC16F18877  24[Jres
G0 I E 23 |RrED
REL[ ]9 22[|ras
rEZ| ]10 21 |rAd
11 12 13 14 15 16 17 18 19 20
Sl[eisislslnislaln
EEREEAEEEE
B~
z

DS50002710A-page 30 © 2018 Microchip Technology Inc.



Using the MPLAB® Code Configurator (MCC)

55.3 Versions

This section of the MCC provides information about the versions of the component
groups that make up MCC. These component groups are called libraries. Intermediate
users can configure the MCC to use a specific version of a library for a given MCC proj-
ect. More information is available in the MCC User's Guide available in the MCC home-
page in the documents section at the bottom of the page:
http://www.microchip.com/mcc

Versions

»
»
»

* T W W W W ¥ W ¥ ¥ ¥ W

4

4

» MPLAB® Code Configurator v3.26.2
/" Core v4.15
w Libraries
w Microchip Technology, Inc.
w» Microcontrollers and Peripherals

PIC10 / PIC12 [ PIC16 f PICIS MCUs (v1.36.1)
PIC24 [ d<PIC33 f PIC32MM MCUs
PIC3ZMX MCUs

w Software

B-hit Bootloader Library

CodP Library

Dac Library

Foundation Services Library (v0.1.21)
LIM Library

LoRaWAN Library

MCP784xy I2C RTCC
MikroElekbranika Cick Library (v1.0.25)
mTouch Capacitive Sensing Library
TCP/IP Lite Stack

Temperature Sensor Library
LCS211x

USB Framework Lite

w Microchip Techonalogy, Inc.

w Software

47X 12C EERAM

© 2018 Microchip Technology Inc.
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Chapter 6. Building a Serial Communications Link

6.1 INTRODUCTION

The purpose of this chapter is to demonstrate how to build the serial communications
link that has been used throughout this document between an MPLAB Xpress Evalua-
tion Board and a host computer. This communication is enabled by a second MCU with
USB capabilities that populates the board along with the target MCU. This second MCU
with USB performs the following USB tasks:

* USB Mass Storage Device (MSD) Class: Receives . hex files from the host PC
and then programs the target device using Microchip's In-Circuit Serial Program-
ming™ (ICSP™) technology.

Note: Hardware debugging is not available. I

« USB Communications Device Class (USB CDC): Translates EUSART data trans-
missions from the target MCU and transmits over the USB connection to the host
PC

Using the latter CDC configuration enables the target MCU to send and receive infor-
mation through the second MCU with USB capabilities to an available USB port on a
host computer. Terminal emulation software (see links in Chapter 2. “Equipment Used”)
running on the host computer connected to the associated COM Port can then be used
to display information from the target MCU or allow the user to send commands back
to the microcontroller.

Target MCU

MCU with USB

3

use

‘ﬂj USB-A Micro B
E 1 el

Data Communication
Host Computer Running MPLAB® Xpress

Terminal Emulation Development Board
Software
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6.2 HOW TO CREATE A NEW PROJECT IN MPLAB XPRESS IDE

At this point only existing projects have been covered. In this section, you will create a
new original project in MPLAB Xpress IDE.

1. Navigate to MPLAB Xpress IDE.
https://mplabxpress.microchip.com/mplabcloud/ide

2. Create a new project by clicking the New Project icon E or by selecting
File>New Project.

Edit View Mavigate Source Refactor Run Debug Team Tools Window Help

] MNew Project... Ctrl+Shift+N ) o o .
T New File.. Ctrl+N
EI| StartPage =2
[e5 Open Project... Ctrl+Shift+0
Open Recent Project L4
Import L4
Close Project

Close Other Projects

Close All Projects

Open File...

Open Recent File L4

Proiect Groups...

3. Inthe New Project window, select “Microchip Embedded” in the “Categories”
frame and “Standalone Project” in the “Projects” frame. Click Next.

New Project n

Steps Choose Project

1. Choose Project Categories: Projects:
2. Select Device W

ct Project Name Microchip Embedded (&4 Standalone Project

Microchip Examples

Description:

Creates a new standalone application project. It uses an IDE-generated makefile to build your project

Next Cancel
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4. Select or type in the MCU being used (PIC16F18877 shown) in the “Device”
drop-down in the Select Device window. Click Next.

New Project n
Steps Select Device
1. Choose Project Family: All Families v
2. Select Devil
3. Selec =
3. Select Project Name Device: | 18877 -
PIC16F188T7

PIC16LF18877

Back Next E Cancel

5. Name the project something relevant, like HelloSerially, in the “Project Name”
field of the Select Project Name window. Click Finish.

New Project “
Steps Select Project Name
1. Choose Project Project Name: | HelloSerially]
2. Select Device
3. Select Project Name
Back Finish Cancel
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The MPLAB Xpress IDE workspace should look similar to below.

A&\ 1DE - MPLAB Xpress x
& - C | @ Secure | https://mplabxpress.microchip.com/mplabcloud/ide
File Edit View Navigate Source Run Debug Tools Window
= o || BRe . o Y

S DIHE P T B [[reoo
Project
a5 Helloserially

(65 Header Files

(63 source Files

Dashboard Output x
22 | % Helloserially
= G Device
@ G PIC16F18877
4| Checksum: Blank, no cods loaded.
' Compiler Taolchain
T xca(142)
& Memory
&% Debug Tool

€ Simulator | Xprass Board

i[F Debug Resources
O Program BP Used: 0 Free: 1000,
[ Data BP Used: 0 Fres: 1000.

6.3 HOW TO SET UP MCC TO GENERATE PROJECT CODE

Once your MPLAB Xpress project is created, you will set up MPLAB Code Configurator
(MCC) options for generating code.

1. Open the MCC plugin by clicking on the @ button at the top of the IDE or
through Tools>Embedded>MPLAB Xpress Code Configurator. For details on the
MCC GUI, see Chapter 5. “Using the MPLAB Code Configurator (MCC)”.

2. Inthe open MCC window, the default parameters for the “Project
Resources>System” can be used.

3. Inthe “Device Resources” area, scroll down to locate the EUSART peripheral
and expand. Double click on the EUSART to add the peripheral to “Project
Resources”.

Device Resources

» o DAC
» A\ osm
v [=]EUSART
v [=]EUSART
EUSART [Foundation Services Library by Microchip Technology, Inc.]
EUSART [PIC10 / P] |2 / PIC16 / PIC18 MCUs by Microchip Technology, Inc.]
> |if4] Ext_Interrupt ,-.I-h'r

» —PAR '. ;

M oasmen
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4. Select the EUSART peripheral under the “Peripheral” heading in the “Project
Resources” pane to open the peripheral configuration and configure as follows:

a) Enable Transmit
b) Baud Rate: 9600 (default)

Y Notifications : 0

Hardware Settings

Mode | asynchronous -

Enable EUSART
Enable Transmit

D Enable Wake-up

[ ] Auto-Baud Detection

Baud Rate: 600

Transmissicn Bits: ‘ 8-bit

Reception Bits: ‘ &-bit

Clock Palarity: ‘ Mon-Trverted

E| Error: 0.160 %

D Enable Address Detect D Enable Cartinuous Receive

[ ] Enable EUSART Interrupts

¥ Software Settings

Software Receive Buffer Size

Redirect STDIO to USART

Software Transmit Buffer Size | 2 - |

5. Inthe “Pin Manager” section, connect the EUSART TX signal to pin RB6 and the
RX signal to pin RB7 by clicking on the blue unlock button, turning it to a green
locked symbol, for the associated signal row and pin columns as shown below.

Module Function Direction 0| 1|2|3|4|5|6|7
RX input CRCRCRCRCRC RG]
EUSART W
X output CRCRC RGN
e LT uadbra

When communicating with the second microcontroller using USB, the RB6 pin is
for the EUSART transmit (TX) signal, and the RB7 pin is for the EUSART receive
(RX) signal on most MPLAB Xpress Evaluation Boards, including the green
“General Purpose MPLAB Xpress Evaluation Board” and 40-pin variants of the
red “Device-Specific MPLAB Xpress Evaluation Boards”. The 20-pin red
“Device-Specific MPLAB Xpress Evaluation Board” will use the RA1 pin for
EUSART TX and the RAO pin for the EUSART RX signal.

© 2018 Microchip Technology Inc.
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6. Click the Generate button in MCC to create the appropriate header and source
files for this configuration.

& MPLAB Xpress Code Configurator

PIC16F18877 Undo Redo Save Quit

Generate
[l
Project Resources |;-I |T|-] System |

w System s
Interrupt Module oy Eoy. ¢
Pin Module 7‘:“‘5,90"
System Module &4

v Peripherals

E"'j EUSART [PIC10/ PIC12 / PIC16 / PIC18 MCUs by Microchip Technology, Inc.]

Device Resources

(N
q

& Pernanke

7. The new MCC Generated header and source files should now be present in the
Project window of the MPLAB Xpress IDE including a new mai n. ¢ source file.

File Edit View MNavigate Source Run Debug Tools Window
AEES 9@ 7T -% % |
Project

A (5 Helloserially

Ao ﬁ Hzader Files

E] eusart.h

i E] mcc.h

E] pin_manager.h
Ao E Source Files

E] eusart.c
E] MCC.C

IEI pin_manager.c

E] main.c
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6.4 HOW TO USE THE MCC-GENERATED SERIAL FUNCTION

The MPLAB Code Configurator generates code used to configure the device and
selected peripherals. Additionally, a series of functions are generated for a number of
the selected resources that enable you to write your own code which can facilitate
dynamic system changes to occur at runtime. Function descriptions along with exam-
ple code can be referenced in the associated peripheral's header file.

1. Highlight the eusart . h file under the “Header Files>MCC Generated Files”
folder inside the Project pane of the MPLAB Xpress IDE to open the file.

INTRODL

[ [

2. Scroll through the eusart . h file to locate the EUSART_W i t e() function.

3 main.c = | ] eusarth =

115  uint8_t EUSART Read{veid);

135 |oid EUSART Write(uint8_t txData);

137 #ifgef _cplusplus

Highlight the function and copy using Ctrl+X (Windows keyboard shortcut).

Note: Copy and paste within the MPLAB Xpress IDE must be done using key-
board shortcuts. Using these functions from the toolbar or from the right
click Context Menu is not supported.
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3. Click on the mai n. ¢ source file in the Project pane to open the file and scroll
through the code to locate the // Add your applicati on code comment
inside of the whi | e('1) loop inside mai n() .

Project ’-'E‘] main.c x
.. [ HelloSerially Ié FeiteE e
----- (5 Header Files e
- 50
4. () MEC Generated Files 51
52 void main{void)
------ @ eusart.h 53+ {
) mech o
""" mee. 55 SYSTEM_Initialize();
------ E] pin_manager.h 56
57
----- (55} source Files 58
59
4. () MEC Generated Files %
...... E‘I susart.c I‘Evl
62
...... 3 mecc 63
54
------ ’-'E‘] pin_manager.c 65
...... 3 main.c 68
67
68
69
7@
71
72 while (1)
73 - 1

74 |
75 }
76 1}

77~

78

79

Paste the copied EUSART_W i t e() function at this location and replace the
arguments within the brackets to a character such as 'A'.

78
71
72~
73
74
75
76
7T~
78

0

while (1)
i

EUSART Write( '2' )|

¥

4. Compile and download the project . hex file by clicking on the Make and
Program Device button at the top of the MPLAB Xpress IDE.

Program the MPLAB Xpress board by dragging the project . hex file from the
downloads section of the browser and dropping the file into the XPRESS drive
as shown in Chapter 3. “Programming the Evaluation Board”.

5.
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6.5 HOW TO DISPLAY THE SERIAL MESSAGE ON A HOST COMPUTER

1. Open aterminal emulator program (see Section 2.3 “Software”) on the host com-
puter and select the COM port associated with the MPLAB Xpress board.

2. Open the Connection>Options dialog and configure the serial port at the 9600
baud rate that was configured earlier in the project when configuring the
EUSART in MCC.

3. Inside the terminal window, click on the
the Xpress board.

button to establish connection with

Connect

Once communication is established, the terminal window should display the character
added to the EUSART_W i t e() earlier in the project.

-ioix

File Edit Connection View Window Help
New

Open Save Conneck  Disconnect Clear Data Options View Hex Help

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD AI

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

AR RRRRRRRRRRRRRRRRARRRARRARARAARAAAAAARAAAARAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAADDD

ARnaRRRARRARARRARARARRARD

COM12 /9600 8-N-1 @ TX (J RTS () DTR @ DCD
Connected 00:00:50 O RX (JCTS (JDSR @R
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: GETTING STARTED USING
8-BIT MCUs IN THE MPLAB®
MICROCHIP Xpress ECOSYSTEM

Appendix A. MPLAB® Xpress Evaluation Boards

A.1 INTRODUCTION

MPLAB Xpress Evaluation Boards have been designed to work in conjunction with the
cloud-based MPLAB Xpress Integrated Development Environment (IDE). The combi-
nation of the IDE and the MPLAB Xpress Evaluation Board provide a platform for rapid
development of applications without having to download or update the IDE or compil-
ers.

All MPLAB Xpress boards contain two sections:

1. The programmer section, which contains the circuitry necessary to serve as a
dedicated drag-and-drop programmer for the target device using Microchip Tech-
nology's proprietary In-Circuit Serial Programming (ICSP) protocol. In this way,
no additional hardware is needed to program the target device other than a sim-
ple USB connection to a host computer.

2. The application section, which contains the circuitry that is used by the micro-
controller application.

Additionally, MPLAB Xpress Evaluation Boards feature a Communications Device
Class (CDC) interface to facilitate serial communication between the target device and
a host computer.

There are three variants of MPLAB Xpress Evaluation Boards:

1. General Purpose MPLAB Xpress Evaluation Board
2. Device Specific MPLAB Xpress Evaluation Board (20-pin variant)
3. Device Specific MPLAB Xpress Evaluation Board (40-pin variant)

A.2 POWERING THE BOARDS

The MPLAB Xpress Evaluation Boards can be powered in one of two ways, depending
on its usage. It should be noted that only one power source should be connected at a
time.

A.2.1 USB Connector

The USB connector will power the entire MPLAB Xpress Evaluation Board. With USB
power connected, the power LED will always be on (green) to indicate that +3.3V is
available on the board.

A.2.2 2.7V-16V External Power Supply (General Purpose MPLAB
Xpress Board Only)

The external power supply option is available on the General Purpose MPLAB Xpress
Board only. It will also power the entire MPLAB Xpress Evaluation Board. The external
power supply is connected to a Low Dropout (LDO) voltage regulator, configured to
deliver 3.3V to the board. The external power supply range is from 2.7V to 16V, allow-
ing use with two to six primary cells, 9V alkaline batteries, or one or two-cell Li-lon bat-
teries. LED D1 will illuminate green when the external power supply is active and
supplying sufficient voltage.
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A.3 GENERAL PURPOSE EVALUATION BOARD

The MPLAB Xpress General Purpose Evaluation Board features an 8-bit PIC16F18855
microcontroller. This board differs from other variants in that it also features basic inter-
face components to the target device such as LEDs, potentiometer, switch and more.

w N

© 0N A

1 21
[E22

(=3 / Hl
» APPLICATION
PROGRAMMER

PIC16F18855 target microcontroller
Connection header corresponding to target microcontroller pins

mikroBUS™ socket to accommodate a variety of plug-in MikroElektronika Click
Boards that can be used in application development

Four user LEDs

Potentiometer

EMC1001 temperature sensor

Push button switch

Master RESET switch

Power LED:

a) Green: power to target

b) Flashing Red: target being programmed

10. 2.7V-16V Battery/External power connection
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A.4 DEVICE-SPECIFIC EVALUATION BOARDS

The MPLAB Xpress Device Specific Evaluation Boards contain a specific PIC16 or
PI1C18 device the board is targeted towards in addition to the built-in programmer. They
are available in 20-pin and 40-pin variants based on the device.

Target microcontroller

Connection header corresponding to target microcontroller pins
Master RESET switch

Power LED:

a) Green: power to target

b) Flashing Red: target being programmed

5. Selects 5V from USB supply or 3.3V from LDO regulator output to power target
device (default is 3.3V)

LR
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Appendix B. MPLAB® Xpress Evaluation Board Schematics

GENERAL PURPOSE EVALUATION BOARD SCHEMATIC (APPLICATION

SECTION)

FIGURE B-1:
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GENERAL PURPOSE EVALUATION BOARD SCHEMATIC (PROGRAMMER

SECTION)

Using 8-bit MCUs with MPLAB® Xpress

FIGURE B-2:
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20-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC

FIGURE B-3:
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28-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC

Using 8-bit MCUs with MPLAB® Xpress

FIGURE B-4:
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MPLAB® Xpress Evaluation Board Schematics

40-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC

FIGURE B-5:
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